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Complete teacher’s manual for Open office impress 2 Class 1 

 Summaries 

 

 What is ‘Standard toolbar’? 

 Why we use ‘Standard toolbar’? 

 How to take a new slide by using ‘Standard toolbar’? 

 How to open any file with the help of ‘Standard toolbar’? 

 How to convert text document file into a PDF file? 

 How to insert a table with help of ‘Standard toolbar? 

 Why we use ‘Fontwork’ option?  

 How to hide and unhide ‘Standard toolbar’? 

 How to hide and unhide ‘Line and filling toolbar’?  

Now let’s start the video. 

 

1. To stop video time at 1 minute 08 seconds in VLC Media Player. 

 
Stop video here and ask if they can tell how to type in a blank slide? 

Just listen to the answers and play the video again for the correct answer. 

 

2. To stop video time at 1 minute 24 seconds in VLC Media Player. 

 



4 
 

Stop video here and ask how to insert a new slide and how many methods are 

there to insert a new slide’? 

Just listen to the answers and play the video again for the correct answer. 

 

3. To stop video time at 2 minute 03 seconds in VLC Media Player. 

 
Stop video here and ask which option is used for animation? 

Just listen to the answers and play the video again for the correct answer. 

4. To stop video time at 2 minute 21 seconds in VLC Media Player. 

 
Stop video here and ask what should we do to copy an object in different coors? 

Just listen to the answers and play the video again for the correct answer. 

5. To stop video time at 2 minute 48 seconds in VLC Media Player. 

Stop video here and ask students to open ‘Impress file’. 

Just listen to the answers and play the video again for the correct answer. 

6. To stop video time at 4 minute 04 seconds in VLC Media Player. 
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Stop video here and ask students to insert five slides and ask them to type 

something in the first slide and then play the video again. 

 

7. To stop video time at 4 minute 20 seconds in VLC Media Player. 

 
Stop video here and ask students to draw any shape on 2 and 3 slides and also 

ask them to do formatting on these shapes and then play the video again. 

 

8. To stop video time at 4 minutes 40 seconds in VLC Media Player. 

Stop video here and ask students to insert any object with help of ‘Gallery’ 

option and in the 5
th
 slide draw their name with help of ‘Fontwork’ option and 

then play the video again. 

 

9. To stop video time at 4 minutes 52 seconds in VLC Media Player. 

Stop video here and ask students if they’ve done all these five things in impress 

file and then play the video again. 

 

10. To stop video time at 5 minutes 33 seconds in VLC Media Player. 

Stop video here and ask students to insert 5 slides as shown in the video and 

then play the video again. 

 

11. To stop video time at 9 minutes 02 seconds in VLC Media Player. 
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Stop video here and ask students to type the given paragraph as shown in the 

video and also ask if they can type about themselves, then play the video again. 

 

12. To stop video time at 9 minutes 20 seconds in VLC Media Player. 

Stop video here and ask students to select the blank slide as shown in the video 

and then play the video again. 

 

 

13. To stop video time at 9 minutes 50 seconds in VLC Media Player. 

Stop video here and ask students to draw any shape as shown in the video and 

then play the video again. 

 

14. To stop video time at 11 minutes 19 seconds in VLC Media Player. 

Stop video here and ask students to do the formatting on the image as shown in 

the video and then play the video again. 

 

15. To stop video time at 11 minutes 54 seconds in VLC Media Player. 

Stop video here and ask students to draw another shape as shown in the video 

and then play the video again. 

 

16. To stop video time at 13 minutes 00 seconds in VLC Media Player. 

Stop video here and ask students to do the formatting on the image again as 

shown in the video and then play the video again. 

 

17. To stop video time at 14 minutes 54 seconds in VLC Media Player. 

Stop video here and ask students to insert any picture with help of ‘Gallery’ 

option and then play the video again. 

 

18. To stop video time at 16 minutes 04 seconds in VLC Media Player. 

Stop video here and ask students to apply the master pages on the 4
th

 slide as 

shown in the video and then play the video again. 

 

19. To stop video time at 18 minutes 25 seconds in VLC Media Player. 

Stop video here and ask the students to write their name with help of 

‘Fontwork’ as shown in the video and then play the video again. 

 

20. To stop video time at 18 minutes 35 seconds in VLC Media Player. 
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Stop video here and ask them if they remember what is ‘Standard toolbar’? 

Just listen to the answers and play the video again for the correct answer. 

 

21. To stop video time at 19 minutes 28 seconds in VLC Media Player. 

 
Stop video here and ask them, there are how many methods to take a new 

‘Impress file’? 

Just listen to the answers and play the video again for the correct answer. 

 

22. To stop video time at 19 minutes 59 seconds in VLC Media Player. 

 
Stop video here and ask if they know which shortcut command will you need to 

use to bring up a new slide. 
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23. To stop video time at 20 minutes 52 seconds in VLC Media Player. 

Stop video here and ask students to take a new file by the first method as shown 

in the video and then play the video again. 

 

24. To stop video time at 21 minutes 23 seconds in VLC Media Player. 

Stop video here and ask students to take a new file by the second method as 

shown in the video and then play the video again. 

 

 

25. To stop video time at 21 minutes 51 seconds in VLC Media Player. 

Stop video here and ask students to take a new file by the third method as 

shown in the video. 

Now just check whether they have completed the task or not and then play the 

video again. 

 

26. To stop video time at 21 minutes 58 seconds in VLC Media Player. 

 
Stop video here and ask which shortcut command will be used to open ‘Impress 

file’? 

Just listen to the answers and play the video again for the correct answer. 

 

27. To stop video time at 22 minutes 13 seconds in VLC Media Player. 
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Stop video here and ask if they can open ‘Impress file’ with help of ‘Standard 

toolbar’? 

Just listen to the answers and play the video again for the correct answer. 

 

28. To stop video time at 22 minutes 44 seconds in VLC Media Player. 

Stop video here and ask students to close their current file and ask them to open 

impress file again as shown in the video and then play the video again. 

 

 

29. To stop video time at 23 minutes 16 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

30. To stop video time at 24 minutes 20 seconds in VLC Media Player. 

Stop video here and ask students to open their file with help of ‘Open’ option as 

shown in the video and then play the video again. 

 

31. To stop video time at 25 minutes 36 seconds in VLC Media Player. 

Stop video here and ask students to click on the ‘Document as email’ option as 

shown in the video and then play the video again. 

 

32. To stop video time at 26 minutes 19 seconds in VLC Media Player. 

Stop video here and ask students to use the ‘Send’ option as shown in the video 

and then play the video again. 

Note: - tell students there is no need to click on ‘Send’ button since internet 

connection is required to send an email. 

 

33. To stop video time at 26 minutes 55 seconds in VLC Media Player. 

 
Stop video here and ask, if they know why we use ‘Export as PDF’ option 
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Just listen to the answers and play the video again for the correct answer. 

 

34. To stop video time at 29 minutes 07 seconds in VLC Media Player. 

Stop video here and ask students to convert their file into pdf format as shown 

in the video and then play the video again. 

 

35. To stop video time at 29 minutes 29 seconds in VLC Media Player. 

Stop video here and check whether they have converted their file into PDF or 

not and then play the video again. 

 

36. To stop video time at 30 minutes 38 seconds in VLC Media Player. 

Stop video here and ask students to see the video and understand how to use 

‘Print directly’ option and then play the video again. 

Note: - printer machine should be connected with the system for printing so 

there is no need to click on the ‘Print directly option’. 

 

37. To stop video time at 30 minutes 51 seconds in VLC Media Player. 

 
Stop video here and ask students if they can use ‘Copy’, ‘Cut’ and ‘Paste’ 

option? 

Just listen to the answers and play the video again for the correct answer. 

 

38. To stop video time at 32 minutes 00 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

39. To stop video time at 33 minutes 22 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now just check whether they have used copy, cut and paste option or not and 

then play the video. 
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40. To stop video time at 33 minutes 36 seconds in VLC Media Player. 

 
Stop video here and ask why we use ‘Format paintbrush’? 

Just listen to the answers and play the video again for the correct answer. 

 

41. To stop video time at 34 minutes 37 seconds in VLC Media Player. 

Stop video here and ask students to draw an object as shown in the video and 

then play the video again. 

 

42. To stop video time at 35 minutes 07 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

43. To stop video time at 36 minutes 20 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now just check whether they have used ‘Format paintbrush’ option or not and 

then play the video. 

 

44. To stop video time at 36 minutes 36 seconds in VLC Media Player. 

 
Stop video here and ask students if they can use ‘Undo and Redo’ option? 

Just listen to the answers and play the video again for the correct answer. 
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45. To stop video time at 37 minutes 48 seconds in VLC Media Player. 

Stop video here and ask students to remove the object by using ‘Undo’ option as 

shown in the video and then play the video again. 

 

46. To stop video time at 38 minutes 34 seconds in VLC Media Player. 

Stop video here and ask students to bring back that object with help of ‘Redo’ 

which they had removed and then play the video again. 

 

 

47. To stop video time at 39 minutes 28 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now just check whether they have used ‘Undo and Redo’ option or not and then 

play the video. 

 

48. To stop video time at 40 minutes 02 seconds in VLC Media Player. 

 
Stop video here and ask students, if they know what we will do to give the link 

of another document on slide. 

Just listen to the answers and play the video again for the correct answer. 

 

49. To stop video time at 41 minutes 47 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

50. To stop video time at 43 minutes 42 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now just check whether they have used ‘Hyperlink’ option or not and then play 

the video. 

 

51. To stop video time at 43 minutes 28 seconds in VLC Media Player. 
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Stop video here and ask if they will be able to draw a table? 

Just listen to the answers and play the video again for the correct answer. 

 

52. To stop video time at 44 minutes 09 seconds in VLC Media Player. 

Stop video here and ask students to take a new slide as shown in the video and 

then play the video again. 

 

53. To stop video time at 44 minutes 21 seconds in VLC Media Player. 

Stop video here and students to click on ‘Table’ option as shown in the video 

and then play the video again. 

 

54. To stop video time at 45 minutes 14 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now just check whether they have drawn ‘Table ‘or not and then play the video. 

 

55. To stop video time at 45 minutes 22 seconds in VLC Media Player. 

 
Stop video here and ask what is ‘Display grid’ option? 

Just listen to the answers and play the video again for the correct answer. 

56. To stop video time at 46 minutes 42 seconds in VLC Media Player. 

Stop video here and ask students to show and hide ‘Grid lines’ as shown in the 

video and then play the video again. 
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57. To stop video time at 46 minutes 50 seconds in VLC Media Player. 

 
Stop video here and ask if they can hide and unhide ‘Standard toolbar’ option? 

Just listen to the answers and play the video again for the correct answer. 

 

58. To stop video time at 48 minutes 31 seconds in VLC Media Player. 

Stop video here and ask students to hide ‘Standard toolbar option as shown in 

the video and then play the video again. 

 

59. To stop video time at 49 minutes 30 seconds in VLC Media Player. 

Stop video here and ask students to show ‘Standard toolbar’ option as shown in 

the video and then play the video again. 

 

60. To stop video time at 51 minutes 53 seconds in VLC Media Player. 

Stop video here and ask students to hide ‘Line and filling’ option as shown in 

the video and then play the video again. 

 

61. To stop video time at 52 minutes 46 seconds in VLC Media Player. 

Stop video here and ask students to unhide ‘Line and filling’ option as shown in 

the video and then play the video again. 

 

62. To stop video time at 52 minutes 54 seconds in VLC Media Player. 
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Stop video here and ask students to close their file and shout down the 

computer. 
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Complete teacher’s manual for Open office impress 2 Class 2 

 

 What is ‘Standard toolbar’? 

 Why we use ‘Standard toolbar’? 

 How to take a new slide by using ‘Standard toolbar’? 

 How to open any file with help of ‘Standard toolbar’? 

 How to convert text document file into a PDF file? 

 How to insert a table with help of ‘Standard toolbar? 

 Why we use ‘Fontwork’ option?  

 How to hide and unhide ‘Standard toolbar’? 

 How to hide and unhide ‘Line and filling toolbar’?  

Now let’s start the video. 

 

63. To stop video time at 26 seconds in VLC Media Player. 

 
Stop video here and ask why we ‘Standard toolbar? 

Just listen to the answers and play the video again for the correct answer. 

 

64. To stop video time at 1 minute 07 seconds in VLC Media Player. 

 
Stop video here and ask how to hide and show standard toolbar? 

Just listen to the answers and play the video again for the correct answer. 
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65. To stop video time at 1 minute 43 seconds in VLC Media Player. 

 
Stop video here and ask if they know what is ‘Display Grid’? 

Just listen to the answers and play the video again for the correct answer. 

 

66. To stop video time at 1 minute 59 seconds in VLC Media Player. 

 
Stop video here and ask if they know why we ‘Chart’? 

Just listen to the answers and play the video again for the correct answer. 

 

67. To stop video time at 2 minute 19 seconds in VLC Media Player. 

 
Stop video here and ask do you know what is ‘Print file directly’? 

Just listen to the answers and play the video again for the correct answer. 
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68. To stop video time at 2 minute 33 seconds in VLC Media Player. 

 
Stop video here and ask students to open ‘Impress file’ and then play the video 

again. 

 

To stop video time at 2 minute 44 seconds in VLC Media Player. 

 
Stop video here and ask students to type the given paragraph on the first slide 

and then play the video again. 

 

To stop video time at 2 minute 50 seconds in VLC Media Player. 

 
Stop video here and ask students to do formatting on the given paragraph as 

shown in the video and then play the video again. 
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69. To stop video time at 2 minute 54 seconds in VLC Media Player. 

 
Stop video here and check whether they have finished the typing or not and then 

play the video again. 

 

70. To stop video time at 4 minute 24 seconds in VLC Media Player. 

Stop video here and ask students to change the ‘Font style’ as shown in the 

video and then play the video again. 

 

71. To stop video time at 5 minute 04 seconds in VLC Media Player. 

Stop video here and ask students to change the font size of the paragraph as 

shown in the video and then play the video again. 

 

72. To stop video time at 5 minute 50 seconds in VLC Media Player. 

Stop video here and ask students to do ‘Bold’ and ‘Underline’ as shown in the 

video and then play the video again. 

 

73. To stop video time at 6 minute 51 seconds in VLC Media Player. 

Stop video here and ask students to change the ‘Font color’ as shown in the 

video and then play the video again. 

 

74. To stop video time at 7 minute 06 seconds in VLC Media Player. 

Stop video here and ask students to apply ‘Bullets’ on the line as shown in the 

video. 

Now just check whether they have changed the formatting of paragraph or not 

and then play the video again. 

 

75. To stop video time at 7 minute 13 seconds in VLC Media Player. 

Stop video here and ask if they can tell there are how many methods to insert a 

new slide? 
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Just listen to the answers and play the video again for the correct answer. 

 

76. To stop video time at 7 minute 54 seconds in VLC Media Player. 

Stop video here and ask students to draw a rectangle and also ask to change the 

formatting of the rectangle and then play the video again. 

 

77. To stop video time at 8 minute 26 seconds in VLC Media Player. 

Stop video here and ask students to insert a new blank slide as shown in the 

video and then play the video again. 

 

78. To stop video time at 9 minute 09 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

79. To stop video time at 10 minute 05 seconds in VLC Media Player. 

Stop video here and ask students to do the formatting on the rectangle as shown 

in the video and then play the video again. 

 

80. To stop video time at 10 minute 21 seconds in VLC Media Player. 

 
Stop video here and ask students to draw a table in slide and then play the video 

again. 

 

81. To stop video time at 11 minute 32 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

82. To stop video time at 16 minute 42 seconds in VLC Media Player. 

Stop video here and ask students to type the data in the table as shown in the 

video. 
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Now just check and play the video again. 

 

83. To stop video time at 16 minute 27 seconds in VLC Media Player. 

 
Stop video here and ask if they can change the design of the table? 

Just listen to the answers and play the video again for the correct answer. 

 

84. To stop video time at 17 minute 48 seconds in VLC Media Player. 

Stop video here and ask students to change the design of the table as shown in 

the video. 

Now just check and play the video again. 

 

85. To stop video time at 18 minute 01 seconds in VLC Media Player. 

 
Stop video here and ask students to insert a new slide and link another 

document with help of ‘Hyperlink’ and then play the video again. 

 

 

 

86. To stop video time at 18 minute 40 seconds in VLC Media Player. 

Stop video here and ask students to insert a new slide as shown in the video and 

then play the video again. 
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87. To stop video time at 19 minute 50 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

88. To stop video time at 20 minute 59 seconds in VLC Media Player. 

Now just check whether they inserted ‘Hyperlink’ or not and play the video 

again. 

 

89. To stop video time at 21 minute 08 seconds in VLC Media Player. 

 
Stop video here and ask students to do ‘Copy’ and ‘Paste’ of slide number 3 and 

4 and then play the video again. 

 

90. To stop video time at 21 minutes 03 seconds in VLC Media Player. 

Stop video here and ask students to copy the slides as shown in the video and 

then play the video again. 

91. To stop video time at 22 minutes 24 seconds in VLC Media Player. 

Stop video here and ask students to ‘Paste’ which they had copied. 

Now just check and play the video again. 

92. To stop video time at 22 minutes 38 seconds in VLC Media Player. 

            
Stop video here and ask students to do ‘Undo’ and ‘Redo’ and then play the 

video again. 

 

93. To stop video time at 23 minutes 19 seconds in VLC Media Player. 
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Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

94. To stop video time at 23 minutes 55 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now just check whether they have practiced ‘Undo’ and ‘Redo’ or not and play 

the video again. 

 

95. To stop video time at 24 minutes 14 seconds in VLC Media Player. 

 
Stop video here and ask students to hide some option of standard toolbars such 

as ‘New’, ‘Hyperlink’, ‘Display Grid’, ‘Copy and Paste’ and ‘Undo and Redo’ 

and then play the video again. 

96. To stop video time at 25 minutes 10 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

97. To stop video time at 26 minutes 54 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now just check whether they have hidden ‘these options’ or not and play the 

video again. 

 

 

 

 

98. To stop video time at 27 minutes 00 seconds in VLC Media Player. 
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Stop video here and ask students to save their file to the ‘Desktop’ and then play 

the video again. 

 

99. To stop video time at 27 minutes 32 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

100. To stop video time at 28 minutes 43 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now just check whether they have saved their file or not and play the video 

again. 

 

101. To stop video time at 28 minutes 59 seconds in VLC Media Player. 

 
Stop video here and ask if they know there are how many methods are there to 

convert ‘PDF’ file? 

Just listen to the answers and play the video again for the correct answer. 

 

102. To stop video time at 30 minutes 25 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

103. To stop video time at 31 minutes 38 seconds in VLC Media Player. 
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Now just check whether they have converted their file into PDF or not and play 

the video again. 

 

104. To stop video time at 31 minutes 49 seconds in VLC Media Player. 

 
Stop video here and ask students to close their file and shout down the 

computer. 
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Complete teacher’s manual for Open office impress 2 Class 3 

 

 How to create a ‘Template’? 

 Why we use ‘Properties’ option? 

 How to send any document to another user? 

 Why we use ‘Printer setting’ option? 

 How to insert a new slide? 

 Why we use ‘Preview in web browser’ option?  

 How to hide and unhide ‘Standard toolbar’? 

 Why we use ‘Line and filling toolbar’?  

Now let’s start the video. 

 

1. To stop video time at 14 seconds in VLC Media Player. 

 
Stop video here and ask if they remember what they had learnt in the previous 

classes of this module. 

Just listen to the answers and play the video again for the correct answer. 

 

2. To stop video time at 23 seconds in VLC Media Player. 

 
Stop video here and ask if they know which options can be kept in ‘Standard 

toolbar’? 

Just listen to the answers and play the video again for the correct answer. 
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3. To stop video time at 40 seconds in VLC Media Player. 

 
Stop video here and ask if they can tell how to type in blank slide? 

Just listen to the answers and play the video again for the correct answer. 

 

4. To stop video time at 53 seconds in VLC Media Player. 

 
Stop video here and ask there are how many methods to insert a new slide? 

Just listen to the answers and play the video again for the correct answer. 

 

5. To stop video time at 1 minute 34 seconds in VLC Media Player. 

Stop video here and ask what will they do to make more than one image of the 

same picture. 

Just listen to the answers and play the video again for the correct answer. 

 

 

 

 

6. To stop video time at 1 minute 53 seconds in VLC Media Player. 
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Stop video here and ask students to open ‘Impress file’ and then play the video 

again. 

 

7. To stop video time at 2 minute 28 seconds in VLC Media Player. 

 
Stop video here and ask students to insert 3 slides and type the given paragraph 

on the first slide and then play the video again. 

 

8. To stop video time at 2 minute 55 seconds in VLC Media Player. 

 
Stop video here and ask students to insert any picture on the second slide and 

then play the video again. 

 

9. To stop video time at 4 minute 00 seconds in VLC Media Player. 
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Stop video here and ask students to insert any picture on the second slide as 

shown in the video and then play the video again. 

 

10. To stop video time at 5 minute 45 seconds in VLC Media Player. 

Stop video here and ask students to draw a shape and also ask to do formatting 

in the drawing as shown in the video and then play the video again. 

 

11. To stop video time at 6 minute 01 seconds in VLC Media Player. 

 
Stop video here and tell students now they will learn about ‘Wizard’ option and 

then play the video again. 

 

12. To stop video time at 6 minute 39 seconds in VLC Media Player. 

Stop video here and ask students to click on ‘File’ menu and then click ‘Wizard’ 

option and then select ‘Letter’ option as shown in the video and then play the 

video again. 

 

13. To stop video time at 7 minute 16 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

14. To stop video time at 8 minute 24 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

15. To stop video time at 9 minute 39 seconds in VLC Media Player. 

Now check whether they have created ‘Letter’ format or not and play the video 

again. 

 

16. To stop video time at 9 minute 51 seconds in VLC Media Player. 
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Stop video here and tell students to click on ‘File’ menu and then click ‘Wizard’ 

option and then select ‘Fax’ option as shown in the video and then play the 

video again. 

 

17. To stop video time at 10 minute 18 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

18. To stop video time at 11 minute 05 seconds in VLC Media Player. 

Stop video here and ask students to click on the next option as shown in the 

video and then play the video again. 

 

19. To stop video time at 10 minute 40 seconds in VLC Media Player. 

Stop video here and ask students to click on the next option as shown in the 

video and then play the video again. 

 

20. To stop video time at 11 minute 45 seconds in VLC Media Player. 

Stop video here and ask students to click on the ‘Finish’ button and then save 

the template as shown in the video. 

Just check whether they have created ‘Fax’ format or not and play the video 

again. 

 

21. To stop video time at 12 minute 23 seconds in VLC Media Player. 

Stop video here and tell students to use the presentation option as shown in the 

video and then play the video again. 

 

22. To stop video time at 13 minute 33 seconds in VLC Media Player. 

Stop video here and tell students to use the ‘Web page’ option as shown in the 

video and then play the video again. 

 

23. To stop video time at 13 minute 48 seconds in VLC Media Player. 

Stop video here and tell students to click on ‘File’ menu and then click ‘Wizard’ 

option and then select ‘Document converter’ option as shown in the video and 

then play the video again. 

 

 

24. To stop video time at 14 minute 53 seconds in VLC Media Player. 
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Stop video here and ask students to use the ‘Document converter’ option as 

shown in the video. 

Now just check whether they have used ‘Wizard’ option or not and play the 

video again. 

 

25. To stop video time at 15 minute 09 seconds in VLC Media Player. 

 
Stop video here and ask if they can tell why we use ‘Send’ option? 

Just listen to the answers and play the video again for the correct answer. 

 

26. To stop video time at 16 minute 57 seconds in VLC Media Player. 

Stop video here and ask students to click on ‘File’ menu and then click 

‘Document as Email’ option as shown in the video and then play the video 

again. 

27. To stop video time at 18 minute 04 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

Note: - tell students there is no need to click on ‘Send’ button since internet 

connection is required to send an email. 

28. To stop video time at 18 minute 25 seconds in VLC Media Player. 

 
Stop video here and ask if they know what happens with ‘Properties’ option? 

Just listen to the answers and play the video again for the correct answer. 
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29. To stop video time at 19 minute 30 seconds in VLC Media Player. 

Stop video here and ask students to click on ‘File’ menu and then click 

‘Properties’ option as shown in the video and then play the video again. 

 

30. To stop video time at 21 minute 21 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

31. To stop video time at 22 minute 34 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now just check and play the video again. 

 

32. To stop video time at 22 minute 44 seconds in VLC Media Player. 

 
Stop video here and ask if they can tell what happens with ‘Printer setting’? 

Just listen to the answers and play the video again for the correct answer. 

 

33. To stop video time at 23 minute 50 seconds in VLC Media Player. 

Stop video here and ask students to click on ‘File’ menu and then click ‘Printer 

setting’ option as shown in the video and then play the video again. 

 

34. To stop video time at 25 minute 50 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

 

35. To stop video time at 26 minute 40 seconds in VLC Media Player. 

Stop video here and ask students to check out the ‘Printing shortcut’ option as 

shown in the video and then play the video again. 
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36. To stop video time at 28 minute 24 seconds in VLC Media Player. 

Stop video here and ask students to use ‘Paper quality and Effects’ as shown in 

the video and then play the video again. 

 

37. To stop video time at 29 minute 48 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now just check whether they have used the ‘Printer setting’ option or not and 

play the video again. 

 

38. To stop video time at 29 minute 57 seconds in VLC Media Player. 

 
Stop video here and ask if they know why we use ‘Template’ option? 

Just listen to the answers and play the video again for the correct answer. 

 

39. To stop video time at 31 minute 05 seconds in VLC Media Player. 

Stop video here and ask students to click on the ‘File’ menu and then select 

‘Template’ option and also ask to save the document as shown in the video and 

then play the video again. 

 

40. To stop video time at 32 minute 57 seconds in VLC Media Player. 

Stop video here and ask students to use ‘Export’ the document as shown in the 

video and then play the video again. 

 

41. To stop video time at 33 minute 25 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now just check whether they have created the ‘Template’ or not and then play 

the video again. 

 

42. To stop video time at 33 minute 26 seconds in VLC Media Player. 
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Stop video here and ask if they can tell why we use ‘Preview in Browser’? 

Just listen to the answers and play the video again for the correct answer. 

 

43. To stop video time at 35 minute 40 seconds in VLC Media Player. 

Stop video here and ask students to use ‘Preview in web browser’ option as 

shown in video and then play the video again. 

 

44. To stop video time at 35 minute 50 seconds in VLC Media Player. 

 
Stop video here and ask students to close their file and shut down the computer. 
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Complete teacher’s manual for Open office impress 2 Class 4 

Summaries 

 

 How to create ‘Template’? 

 Why we use ‘Properties’ option? 

 How to send any document to another user? 

 Why we use ‘Printer setting’ option? 

 How to insert a new slide? 

 Why we use ‘Preview in web browser’ option?  

 How to hide and unhide ‘Standard toolbar’? 

 How to show Standard toolbar? 

 Why we use ‘Line and filling toolbar’?  

Now let’s start the video. 

 

45. To stop video time at 38 seconds in VLC Media Player. 

 
Stop video here and ask if they know what will they do for seeing slides on the 

web browser? 

Just listen to the answers and play the video again for the correct answer. 

 

46. To stop video time at 58 seconds in VLC Media Player. 

  
Stop video here and ask if they can tell how to type in blank slide? 
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Just listen to the answers and play the video again for the correct answer. 

 

47. To stop video time at 1 minute 13 seconds in VLC Media Player. 

 
Stop video here and ask which option will be used for sending a document to 

another user? 

Just listen to the answers and play the video again for the correct answer. 

48. To stop video time at 1 minute 26 seconds in VLC Media Player. 

 
Stop video here and ask if they can tell where is the slide pane located in the 

‘Impress’ file. 

Just listen to the answers and play the video again for the correct answer. 

49. To stop video time at 1 minute 53 seconds in VLC Media Player. 
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Stop video here and ask which option will be used to know all the information 

about ‘Impress’ file? 

Just listen to the answers and play the video again for the correct answer. 

 

50. To stop video time at 2 minute 05 seconds in VLC Media Player. 

Stop video here and ask students to open ‘Impress file’ and then play the video 

again. 

 

51. To stop video time at 2 minute 15 seconds in VLC Media Player. 

 
Stop video here and ask students to insert 3 slides and type the given paragraph 

on the first slide and then play the video again. 

 

52. To stop video time at 2 minute 42 seconds in VLC Media Player. 

 
Stop video here and ask students to do practice of ‘Send’ option and then play 

the video again. 

 

53. To stop video time at 3 minute 32 seconds in VLC Media Player. 

Stop video here and ask students to click on the ‘File’ menu and select 

‘Document as email’ option and then play the video again. 

 

54. To stop video time at 4 minute 51 seconds in VLC Media Player. 
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Stop video here and ask students to do as shown in the video. 

Now just check and play the video again. 

 

55. To stop video time at 5 minute 10 seconds in VLC Media Player. 

 
Stop video here and ask students to apply ‘Template’ option and then play the 

video again. 

 

56. To stop video time at 5 minute 02 seconds in VLC Media Player. 

Stop video here and ask students to click on the ‘File’ menu and then select 

‘Template’ option and then select the save option as shown in the video and 

then play the video again. 

57. To stop video time at 7 minute 42 seconds in VLC Media Player. 

Stop video here and ask students to ‘Export’ the document as shown in the 

video and then play the video again. 

58. To stop video time at 08 minute 23 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now just check whether they have made ‘Template’ or not and play the video 

again. 

59. To stop video time at 08 minute 32 seconds in VLC Media Player. 

 
Stop video here and ask students to create the ‘Fax’ format and the play the 

video again. 
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60. To stop video time at 08 minute 59 seconds in VLC Media Player. 

Stop video here and ask students to click on the ‘File’ menu and then select 

‘Fax’ option of ‘Wizard’ as shown in the video and then play the again. 

 

61. To stop video time at 09 minute 20 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

62. To stop video time at 10 minute 54 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now just check whether they have Created ‘Fax format’ or not and play the 

video again. 

 

63. To stop video time at 10 minute 57 seconds in VLC Media Player. 

 
Stop video here and ask students to do practice of ‘Printer setting’ option and 

then play the video again. 

 

64. To stop video time at 11 minute 29 seconds in VLC Media Player. 

Stop video here and ask students to click on the ‘File’ menu and then select 

‘Printer setting’ option as shown in the video and then play the again. 

 

65. To stop video time at 14 minute 26 seconds in VLC Media Player. 

Stop video here and ask students to use the ‘Advance and Printing setting’ as 

shown in the video and then play the video again. 

 

 

66. To stop video time at 16 minute 06 seconds in VLC Media Player. 
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Stop video here and ask students to use the ‘paper quality and Effect’ as shown 

in the video and then play the video again. 

 

67. To stop video time at 17 minute 30 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now just check whether they have practiced ‘Printer setting’ option or not and 

play the video again. 

 

68. To stop video time at 17 minute 35 seconds in VLC Media Player. 

 

Stop video here and ask students to do practice of ‘Preview in web browser’ and 

then play the video again. 

69. To stop video time at 19 minute 28 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now just check whether they have practiced ‘Preview in web browser’ or not 

and play the video again. 

 

70. To stop video time at 19 minute 40 seconds in VLC Media Player. 

 
Stop video here and ask students to hide some options such as ‘Save’ ‘open’ and 

‘Hyperlink’ from ‘Standard toolbar’ and then play the video again. 
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71. To stop video time at 21 minute 00 seconds in VLC Media Player. 

Stop video here and ask students to unselect these options and click on ‘OK’ 

button as shown in the video and then play the video again. 

 

72. To stop video time at 21 minute 31 seconds in VLC Media Player. 

 

Stop video here and ask students to draw their name on the slide with help of 

‘Fontwork’ option and also do formatting on it and then play the video again. 

 

73. To stop video time at 22 minute 49 seconds in VLC Media Player. 

Stop video here and ask students to insert ‘Font work gallery’ as shown in the 

video and then play the video again. 

 

74. To stop video time at 23 minute 43 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

75. To stop video time at 26 minute 34 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now just check whether they have practiced ‘Fontwork’ option or not and then 

play the video again. 

  

76. To stop video time at 26 minute 49 seconds in VLC Media Player. 
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Stop video here and ask students to bring back those options which they had 

hidden and then play the video again. 

 

77. To stop video time at 28 minute 08 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now just check whether they have gotten back those options or not and then 

play the video again. 

 

78. To stop video time at 28 minute 31 seconds in VLC Media Player. 

 
Stop video here and ask students to close their file and shout down the 

computer. 

 

 

 

 

 

 

 

 

 

 

 



43 
 

Complete teacher’s manual for Open office impress 2 Class 5 

 Summaries 

 

 Why we use ‘Points’ 

 Why we use ‘Glue points’ option? 

 Why we use ‘Field option’? 

 How to do any ‘Formatting on drawing? 

 How to insert a new slide? 

 How to use ‘Slide master’?  

 How to hide and unhide ‘Comments’? 

 How to insert comment? 

 What happens by ‘Navigator’ option? 

 Why we use ‘Zoom’ option? 

 How to insert ‘Date’, ‘Time’ and ‘Page number’? 

 

Now let’s start the video. 

 

79. To stop video time at 54 seconds in VLC Media Player. 

 
Stop video here and ask if they can tell why we use ‘Line and filling’ toolbar? 

Just listen to the answers and play the video again for the correct answer. 

 

80. To stop video time at 3 minute 08 seconds in VLC Media Player. 

Stop video here and ask students to hide and unhide the ‘Slide pane’ as shown 

in the video and then play the video again. 

 

81. To stop video time at 3 minute 22 seconds in VLC Media Player. 
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Stop video here and ask if they know what is ‘Properties option? 

Just listen to the answers and play the video again for the correct answer. 

 

82. To stop video time at 4 minute 01 seconds in VLC Media Player. 

 
Stop video here and ask there are how many methods to print ‘Impress file’? 

Just listen to the answers and play the video again for the correct answer. 

 

83. To stop video time at 4 minute 35 seconds in VLC Media Player. 

Stop video here and ask to if they know which shortcut command will be used 

to get a print out? 

Just listen to the answers and play the video again for the correct answer. 

 

84. To stop video time at 4 minute 47 seconds in VLC Media Player. 
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Stop video here and ask if they know why we use ‘Templates’ option? 

Just listen to the answers and play the video again for the correct answer. 

 

85. To stop video time at 6 minute 00 seconds in VLC Media Player. 

 

Stop video here and ask students to open ‘Impress file’ and then play the video 

again. 

 

86. To stop video time at 6 minute 09 seconds in VLC Media Player. 

 
Stop video here and ask students to type the given paragraph on the first slide 

and then play the video again. 

 

87. To stop video time at 6 minute 08 seconds in VLC Media Player. 
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Stop video here and ask students if they have typed the paragraph? 

Just listen to the answers and play the video again for the correct answer. 

 

88. To stop video time at 6 minute 13 seconds in VLC Media Player. 

Stop video here and ask students to insert 10 (ten) slides. 

Now just check and play the video again. 
 

89. To stop video time at 6 minute 16 seconds in VLC Media Player. 

Stop video here and check whether they have inserted ten slides or not and then 

play the video again. 

 

90. To stop video time at 6 minute 27 seconds in VLC Media Player. 

 
Stop video here and ask students to insert any object using ‘Object’ option and 

then play the video again. 

 

91. To stop video time at 8 minute 15 seconds in VLC Media Player. 

Stop video here and ask students to insert ten slides as shown in the video and 

then play the video again. 
 

92. To stop video time at 10 minute 07 seconds in VLC Media Player. 

Stop video here and ask students to draw shape as shown in the video and then 

play the video again. 

 

93. To stop video time at 14 minute 19 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

94. To stop video time at 15 minute 23 seconds in VLC Media Player. 
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Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

95. To stop video time at 16 minute 08 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now just check whether they have drawn some shapes in slides numbers 2 to 8 

or not and play the video again. 

 

96. To stop video time at 16 minute 20 seconds in VLC Media Player. 

 

Stop video here and ask why use ‘Points’ option? 

Just listen to the answers and play the video again for the correct answer. 

 

97. To stop video time at 17 minute 33 seconds in VLC Media Player. 

Stop video here and ask students to draw a line as shown in the video and then 

play the video again. 

 

98. To stop video time at 17 minute 44 seconds in VLC Media Player. 

Stop video here and ask students to click on the ‘Edit menu’ and then click 

‘Points’ opiton as shown in the video and then play the video again. 

 

99. To stop video time at 18 minute 10 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

100. To stop video time at 18 minute 38 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

101. To stop video time at 19 minute 18 seconds in VLC Media Player. 
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Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

102. To stop video time at 22 minute 44 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now just check whether they have used ‘Points option’ or not and play the 

video again. 
 

103. To stop video time at 22 minute 52 seconds in VLC Media Player. 

 
Stop video here and ask if they know why use ‘Glue Points’ option? 

Just listen to the answers and play the video again for the correct answer. 

 

104. To stop video time at 24 minute 05 seconds in VLC Media Player. 

Stop video here and ask students to draw two shapes as shown in the video and 

then play the video again. 

 

105. To stop video time at 25 minute 20 seconds in VLC Media Player. 

Stop video here and ask students to click on the ‘Edit menu’ and then click 

‘Points’ opiton as shown in the video and then play the video again. 

 

106. To stop video time at 26 minute 00 seconds in VLC Media Player. 

Stop video here and ask students to click on the ‘Edit menu’ and then click 

‘Glue Points’ opiton as shown in the video and then play the video again. 

. 

107. To stop video time at 28 minute 12 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

108. To stop video time at 29 minutes 28 seconds in VLC Media Player. 
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Stop video here and ask students to do as shown in the video. 

Just check and play the video again. 
 

109. To stop video time at 29 minutes 35 seconds in VLC Media Player. 

 
Stop video here and ask if they can tell why we use ‘Fields’ option? 

Just listen to the answers and play the video again for the correct answer. 

 

110. To stop video time at 32 minutes 20 seconds in VLC Media Player. 

Stop video here and ask students to insert ‘Date’, ‘Time’ and ‘Page number’ as 

shown in the video and then play the video again. 

 

111. To stop video time at 33 minutes 14 seconds in VLC Media Player. 

Stop video here and ask students to click on the ‘Edit menu’ and then click 

‘Fields’ opiton as shown in the video and then play the video again. 

 

112. To stop video time at 33 minutes 37 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

113. To stop video time at 34 minutes 42 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now just check whether they have changed formatting of ‘Fields’ or not and 

play the video again. 

 

 

 

 

114. To stop video time at 35 minutes 03 seconds in VLC Media Player. 
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Stop video here and ask students if they remember what options they learnt in 

‘View menu’? 

Just listen to the answers and play the video again for the correct answer. 

 

115. To stop video time at 35 minutes 30 seconds in VLC Media Player. 

 
Stop video here and ask if they can tell why we use ‘Slide master’? 

Just listen to the answers and play the video again for the correct answer. 

 

116. To stop video time at 37 minutes 08 seconds in VLC Media Player. 

Stop video here and ask students to insert a slide and type some lines in slide 

with some title as shown in the video and then play the video again. 

 

117. To stop video time at 39 minutes 02 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

118. To stop video time at 39 minutes 45 seconds in VLC Media Player. 

Stop video here and ask students to insert a new slide and type some lines as 

shown in the video and then play the video again. 

 

119. To stop video time at 40 minutes 00 seconds in VLC Media Player. 
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Stop video here and ask students to click on the ‘Edit menu’ and then click 

‘Slide master’ opiton as shown in the video and then play the video again. 

 

120. To stop video time at 41 minutes 29 seconds in VLC Media Player. 

Stop video here and ask students to do formatting as shown in the video and 

then play the video again. 

 

121. To stop video time at 43 minutes 30 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now just check whether they have used ‘Master slide or not and play the video 

again. 

 

122. To stop video time at 43 minutes 36 seconds in VLC Media Player. 

 
Stop video here and ask if they can tell why we use the ‘Color and grayscale’ 

option? 

Just listen to the answers and play the video again for the correct answer. 

 

123. To stop video time at 44 minutes 35 seconds in VLC Media Player. 

Stop video here and ask students to do formatting as shown in the video and 

then play the video again. 

124. To stop video time at 45 minutes 29 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now just check whether they have used ‘color and grayscale’ or not and then 

play the video again. 

 

 

125. To stop video time at 45 minutes 47 seconds in VLC Media Player. 
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Stop video here and ask students to hide and unhide the comment box as and 

then play the video again. 

 

126. To stop video time at 46 minutes 31 seconds in VLC Media Player. 

Stop video here and ask students to click on the ‘Insert menu’ and then select 

‘Comment’ option as shown in the video and then play the video again. 

 

127. To stop video time at 47 minutes 21 seconds in VLC Media Player. 

Stop video here and ask students to type some lines in the ‘Comment box’ as 

shown in the video and then play the video again. 

 

128. To stop video time at 48 minutes 22 seconds in VLC Media Player. 

Stop video here and ask students to hide and unhide the ‘Comment’ as shown in 

the video and then play the video again. 

 

129. To stop video time at 48 minutes 29 seconds in VLC Media Player. 

 
Stop video here and ask if they know what happens with ‘Navigator’ and why 

we use it? 

Just listen to the answers and play the video again for the correct answer. 

 

130. To stop video time at 49 minutes 29 seconds in VLC Media Player. 
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Stop video here and ask students to click on the ‘View’ menu’ and then select 

‘Navigator’ option as shown in the video and then play the video again. 

 

131. To stop video time at 50 minutes 07 seconds in VLC Media Player. 

Stop video here and ask students to move one slide to another with help of 

‘Navigator’ option as shown in the video and then play the video again. 

 

132. To stop video time at 51 minutes 46 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now just check whether they have used ‘Navigator’ or not and play the video 

again. 

 

133. To stop video time at 52 minutes 48 seconds in VLC Media Player. 

Stop video here and ask students to click on the ‘View’ menu’ and then select 

‘Zoom’ option as shown in the video and then play the video again. 

 

134. To stop video time at 53 minutes 08 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

135. To stop video time at 53 minutes 40 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

136. To stop video time at 54 minutes 41 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

137. To stop video time at 56 minutes 22 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now just check whether they have used ‘Zoom’ or not and play the video again. 

 

 

 

 

138. To stop video time at 56 minutes 32 seconds in VLC Media Player. 
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Stop video here and ask students to close their file and shut down the computer. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



55 
 

Complete teacher’s manual for Open office impress 2 Class 6 

Summaries 

 

 Why we use ‘Points’ 

 How to make a slide in normal view? 

 Why we use ‘Glue points’ option? 

 Why we use ‘Field option’? 

 How to do any ‘Formatting on drawing? 

 How to insert a new slide? 

 How to use ‘Slide master’?  

 How to hide and unhide ‘Comments’? 

 How to insert comment? 

 What happens by ‘Navigator’ option? 

 Why we use ‘Zoom’ option? 

 How to insert ‘Date’, ‘Time’ and ‘Page number’? 

 

Now let’s start the video. 

 

139. To stop video time at 1 minute 06 seconds in VLC Media Player. 

 
Stop video here and ask if they know which shortcut command will be used for 

‘Slide show’? 

Just listen to the answers and play the video again for the correct answer. 

 

140. To stop video time at 1 minute 22 seconds in VLC Media Player. 
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Stop video here and ask if they can tell what happens with ‘side bar’ and how to 

hide this? 

Just listen to the answers and play the video again for the correct answer. 

 

141. To stop video time at 1 minute 54 seconds in VLC Media Player. 

 
Stop video here and ask if slide view has been changed, how to bring back in 

normal view? 

Just listen to the answers and play the video again for the correct answer. 

 

142. To stop video time at 2 minute 17 seconds in VLC Media Player. 

 
Stop video here and ask if they can tell why we use ‘Fields’ option? 

Just listen to the answers and play the video again for the correct answer. 
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143. To stop video time at 2 minute 34 seconds in VLC Media Player. 

 
Stop video here and ask students to open ‘Impress file’ and then play the video 

again. 

 

144. To stop video time at 2 minute 52 seconds in VLC Media Player. 

 
Stop video here and ask if they can tell what they learnt in previous class? 

Just listen to the answers and play the video again for the correct answer. 

 

145. To stop video time at 3 minute 10 seconds in VLC Media Player. 

 
Stop video here and ask students to insert 4 slides and type the given paragraph 

on the first slide and then play the video again. 
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146. To stop video time at 3 minute 21 seconds in VLC Media Player. 

 
Stop video here and ask students to change their name style with help of ‘Font 

work’ and then play the video again. 

 

147. To stop video time at 4 minute 09 seconds in VLC Media Player. 

Stop video here and ask students to insert three slides as shown in the video and 

then play the video again. 

 

148. To stop video time at 4 minute 46 seconds in VLC Media Player. 

Stop video here and ask students to select any ‘Font work’ style as shown in the 

video and then play the video again.  

 

149. To stop video time at 5 minute 35 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

150. To stop video time at 6 minute 50 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now just check whether they have used ‘Font work’ or not and play the video 

again. 

 

151. To stop video time at 7 minute 02 seconds in VLC Media Player. 
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Stop video here and ask them if they know how many ways one can view a 

slide? 

Just listen to the answers and play the video again for the correct answer. 

 

152. To stop video time at 7 minute 27 seconds in VLC Media Player. 

 
Stop video here and ask the students to change the view of the slide and bring 

back into normal view and then play the video again. 

 

153. To stop video time at 8 minute 27 seconds in VLC Media Player. 

Stop video here and ask students to change the view of the slide as shown in the 

video and then play the video again. 

 

154. To stop video time at 10 minute 21 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now just check whether they have changed the view of the slides or not and 

play the video again. 

 

155. To stop video time at 10 minute 40 seconds in VLC Media Player. 
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Stop video here and ask students to insert some pictures and write some 

comments on the slide and then play the video again. 

 

156. To stop video time at 12 minute 04 seconds in VLC Media Player. 

Stop video here and ask students to insert the comment box and type some text 

in it as shown in the video and then play the video again. 

 

157. To stop video time at 13 minute 14 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now just check whether they have hidden the comments or not and play the 

video again. 

 

158. To stop video time at 12 minute 21 seconds in VLC Media Player. 

 
Stop video here and ask, how to see the picture in the slide and how to move 

from one picture to another? 

Just listen to the answers and play the video again for the correct answer. 

 

159. To stop video time at 14 minute 21 seconds in VLC Media Player. 

Stop video here and ask students to click on the ‘View menu’ and then select 

the ‘Navigator’ option as shown in the video and then play the video again. 
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160. To stop video time at 15 minute 47 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now just check whether they have practiced ‘Navigator’ option or not and then 

play the video again. 

 

161. To stop video time at 16 minute 02 seconds in VLC Media Player. 

 
Stop video here and ask students to show ‘Comment’ which they had hidden 

and type ‘Computer Shiksha’ in the comment box and then play the video again. 

 

162. To stop video time at 16 minute 54 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now just check whether they have shown the ‘Comment’ or not and then play 

the video again. 

 

163. To stop video time at 17 minute 05 seconds in VLC Media Player. 

 
Stop video here and ask students, how will they show and use the master slide 

option? 

Just listen to the answers and play the video again for the correct answer. 
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164. To stop video time at 17 minute 51 seconds in VLC Media Player. 

Stop video here and ask students to click on the ‘View menu’ and then click on 

the ‘Master slide’ as shown in the video and then play the video again. 

 

165. To stop video time at 19 minute 55 seconds in VLC Media Player. 

Stop video here and ask students to do the formatting as shown in the video and 

then play the video again. 

 

166. To stop video time at 21 minute 17 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

167. To stop video time at 22 minute 18 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now just check whether they have practiced ‘Master slide’ or not and then play 

the video again. 

 

168. To stop video time at 22 minute 22 seconds in VLC Media Player. 

 
Stop video here and ask how will they hide ‘Side bar’? 

Just listen to the answers and play the video again for the correct answer. 

 

169. To stop video time at 23 minute 49 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now just check whether they have practiced the ‘Sidebar’option or not and play 

the video again. 

 

170. To stop video time at 23 minute 59 seconds in VLC Media Player. 
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Stop video here and ask students to hide ‘Line and filling, ‘Drawing bar’ and 

‘Standard toolbar’ and then play the video again. 

 

171. To stop video time at 24 minute 40 seconds in VLC Media Player. 

Stop video here and ask students to hide ‘Drawing toolbar’ as shown in the 

video and then play the video again. 

 

172. To stop video time at 25 minute 41 seconds in VLC Media Player. 

Stop video here and ask students to hide ‘Line and filling’ toolbar’ and 

‘Standard toolbar’ as shown in the video. 

Now just check whether they have used the ‘Toolbar’ option or not and then 

play the video again. 

 

173. To stop video time at 25 minute 49 seconds in VLC Media Player. 

 
Stop video here and ask students to show ‘Standard toolbar’, ‘Line and filling’ 

and ‘Drawing toolbar’ then play the video again. 

 

174. To stop video time at 24 minute 51 seconds in VLC Media Player. 

Stop video here and ask students to show ‘Drawing toolbar’ as shown in the 

video and then play the video again. 

175. To stop video time at 27 minute 40 seconds in VLC Media Player. 
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Stop video here and ask students to do show ‘Line and filling’ toolbar’ and 

‘Standard toolbar’ as shown in the video. 

Now just check and play the video again. 

 

176. To stop video time at 27 minute 57 seconds in VLC Media Player. 

 
Stop video here and ask students to draw two objects and join them with help of 

‘Glue points’ and then play the video again. 

 

177. To stop video time at 28 minute 47 seconds in VLC Media Player. 

Stop video here and ask students to draw two objects as shown in the video and 

then play the video again. 

 

178. To stop video time at 29 minute 50 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now just check whether they have practiced ‘Glue points’ or not and then play 

the video again. 

 

179. To stop video time at 30 minute 21 seconds in VLC Media Player. 

 
Stop video here and ask students to draw a line and use ‘Points in this line and 

then play the video again. 
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180. To stop video time at 31 minute 07 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

181. To stop video time at 31 minute 02 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

182. To stop video time at 32 minute 10 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now just check whether they practiced ‘Points’ or not and play the video again. 

 

183. To stop video time at 32 minute 13 seconds in VLC Media Player. 

 
Stop video here and ask students to close their file and shut down the computer. 
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Complete teacher’s manual for Open office Impress 2 Class 7 

 Summaries 

 

 Why we use ‘Expand and summary slide’? 

 Why we use ‘animated image’ option? 

 Why we use ‘Movie and sound’? 

 What is ‘object’ and ‘chart’ option? 

 Why we use ‘position and size’? 

 Why we use ‘line’ option? 

 What is area option? 

 How to crop a picture? 

 How to use style and formatting? 

 How to correct spelling? 

 How to change language? 

 

Now let’s start the video. 

 

184. To stop video time at 27 seconds in VLC Media Player. 

 
Stop video here and ask if they can tell what they learnt in previous class? 

Just listen to the answers and play the video again for the correct answer. 

 

185. To stop video time at 45 seconds in VLC Media Player. 
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Stop video here and ask what they had learnt in ‘Standard toolbar’ option? 

Just listen to the answers and play the video again for the correct answer. 

 

186. To stop video time at 1 minute 15 seconds in VLC Media Player. 

 
Stop video here and ask if they can tell how to hide ‘Grid’ from ‘Impress file’? 

Just listen to the answers and play the video again for the correct answer. 

 

187. To stop video time at 1 minute 35 seconds in VLC Media Player. 

 
Stop video here and ask if they know why we use ‘Points’ option? 

Just listen to the answers and play the video again for the correct answer. 

 

188. To stop video time at 2 minute 00 seconds in VLC Media Player. 
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Stop video here and ask if they can tell why we use ‘Fields’ option? 

Just listen to the answers and play the video again for the correct answer. 

 

189. To stop video time at 2 minute 22 seconds in VLC Media Player. 

 
Stop video here and ask if they can tell why we use ‘Hyperlink’ option? 

Just listen to the answers and play the video again for the correct answer. 

 

190. To stop video time at 2 minute 44 seconds in VLC Media Player. 

 
Stop video here and ask students to open ‘Impress file’ and then play the video 

again. 
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191. To stop video time at 3 minute 56 seconds in VLC Media Player. 

Stop video here and ask students to type the given paragraph on the slide and 

then play the video again. 

 

192. To stop video time at 4 minute 01 seconds in VLC Media Player. 

Stop video here and check whether they have typed paragraph or not and then 

play the video again. 

 

193. To stop video time at 4 minute 14 seconds in VLC Media Player. 

 
Stop video here and ask if they know why we use ‘Summary slide’ option? 

Just listen to the answers and play the video again for the correct answer. 

 

194. To stop video time at 6 minute 17 seconds in VLC Media Player. 

Stop video here and ask students to insert a slide and then give the title and also 

draw an object as shown in the video and then play the video again. 

 

195. To stop video time at 6 minute 45 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now just check and then play the video again. 

 

196. To stop video time at 7 minute 03 seconds in VLC Media Player. 
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Stop video here and ask if they can tell why we use ‘Expand slide’ option? 

Just listen to the answers and play the video again for the correct answer. 

 

197. To stop video time at 8 minute 20 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now just check whether they have applied Expand slide or not and play the 

video again. 

 

198. To stop video time at 8 minute 30 seconds in VLC Media Player. 

 
Stop video here and ask if they know why we use ‘Animated image’ option? 

Just listen to the answers and play the video again for the correct answer. 

 

199. To stop video time at 9 minute 31 seconds in VLC Media Player. 

Stop video here and ask students to click on the ‘Insert menu’ and then select 

‘Animated image’ as shown in the video and then play the video again. 

 

200. To stop video time at 10 minute 02 seconds in VLC Media Player. 

Stop video here and ask students to insert a picture and click on the apply object 

as shown in the video and then play the video again. 

 

201. To stop video time at 10 minute 40 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

202. To stop video time at 11 minute 30 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

203. To stop video time at 12 minute 41seconds in VLC Media Player. 
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Stop video here and ask students to click on the ‘Apply object’ and then click 

on the ‘Create’ option as shown in the video and then play the video again. 

 

204. To stop video time at 13 minute 29 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now just check and then play the video again. 

 

205. To stop video time at 14 minute 25 seconds in VLC Media Player. 

Stop video here and ask students to click on ‘Insert menu’ and then click on the 

‘Movie and Sound’ as shown in the video and then play the video again. 

 

206. To stop video time at 15 minute 03 seconds in VLC Media Player. 

Stop video here and ask students to insert any video as shown in the video and 

then play the video again. 

 

207. To stop video time at 16 minute 28 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now just check whether they have inserted a video or not and then play the 

video again. 

 

208. To stop video time at 16 minute 31 seconds in VLC Media Player. 

 
Stop video here and ask if they can tell why we use ‘Object’ option? 

Just listen to the answers and play the video again for the correct answer. 

 

209. To stop video time at 17 minute 48 seconds in VLC Media Player. 

Stop video here and ask students to click on the ‘Insert menu’ and then click on 

‘Object’ as shown in the video and then play the video again. 

 

210. To stop video time at 18 minute 14 seconds in VLC Media Player. 
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Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

211. To stop video time at 20 minute 53 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now just check and then play the video again. 

 

212. To stop video time at 22 minute 34 seconds in VLC Media Player. 

Stop video here and ask students to draw an object and also ask to copy and 

paste as shown in the video and then play the video again. 

 

213. To stop video time at 22 minute 50 seconds in VLC Media Player. 

Stop video here and ask students to click on the ‘Format menu’ and then click 

on ‘Position and size’ as shown in the video and then play the video again. 

 

214. To stop video time at 23 minute 09 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

215. To stop video time at 24 minute 54 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

216. To stop video time at 26 minute 28 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

217. To stop video time at 27 minute 13 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now just check whether they have used ‘Position and Size’ option or not and 

then play the video again. 

 

218. To stop video time at 28 minute 11 seconds in VLC Media Player. 

Stop video here and ask students to draw a ‘Line’ as shown in the video and 

then play the video again. 

 

219. To stop video time at 28 minute 37 seconds in VLC Media Player. 
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Stop video here and ask students to click on the ‘Format menu’ and then click 

on ‘Line’ as shown in the video and then play the video again. 

 

220. To stop video time at 29 minute 14 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

221. To stop video time at 30 minute 14 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

222. To stop video time at 32 minute 47 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now just check whether they have used the ‘Line’ option or not and then play 

the video again. 

 

223. To stop video time at 32 minute 55 seconds in VLC Media Player. 

 
Stop video here and ask if they know why we use ‘Area’ option? 

Just listen to the answers and play the video again for the correct answer. 

 

224. To stop video time at 33 minute 51 seconds in VLC Media Player. 

Stop video here and ask students to click on the ‘Format menu’ and then click 

on ‘Area’ as shown in the video and then play the video again. 

 

225. To stop video time at 34 minute 35 seconds in VLC Media Player. 

Stop video here and ask students to use the ‘Shadow’ option as shown in the 

video and then play the video again. 

 

226. To stop video time at 35 minute 43 seconds in VLC Media Player. 
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Stop video here and ask students to use the ‘Transparency’ option as shown in 

the video and then play the video again.. 

 

227. To stop video time at 38 minute 30 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

228. To stop video time at 40 minute 56 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now just check whether they have used ‘Area’ option and then play the video 

again. 

 

229. To stop video time at 41 minute 02 seconds in VLC Media Player. 

 
Stop video here and ask if they know what happens with ‘Text’ option? 

Just listen to the answers and play the video again for the correct answer. 

 

230. To stop video time at 41 minute 50 seconds in VLC Media Player. 

Stop video here and ask students to click on the ‘Format menu’ and then click 

on ‘Text’ as shown in the video and then play the video again. 

 

231. To stop video time at 42 minute 20 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

232. To stop video time at 43 minute 26 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

233. To stop video time at 45 minute 16 seconds in VLC Media Player. 
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Stop video here and ask students to do as shown in the video. 

Now just check whether they have applied text animation or not and then play 

the video again. 

 

234. To stop video time at 45 minute 20 seconds in VLC Media Player. 

 
Stop video here and ask if they know why we ‘Crop picture’? 

Just listen to the answers and play the video again for the correct answer. 

 

235. To stop video time at 46 minute 28 seconds in VLC Media Player. 

Stop video here and ask students to click on the ‘Format menu’ and then click 

on ‘Crop picture’ as shown in the video and then play the video again. 

 

236. To stop video time at 47 minute 46 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

237. To stop video time at 48 minute 47 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now just check whether they have used ‘Crop picture’ or not and play the video 

again. 

 

238. To stop video time at 49 minute 40 seconds in VLC Media Player. 

Stop video here and ask students to click on the ‘Format’ and then click on 

‘Style and formatting’ as shown in the video and then play the video again. 

 

239. To stop video time at 50 minute 21 seconds in VLC Media Player. 

Stop video here and ask students to change the background color of the slide as 

shown in the video and then play the video again. 
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240. To stop video time at 51 minute 21 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

241. To stop video time at 52 minute 30 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now just check whether they have used ‘Formatting and style’ or not and play 

the video again. 

 

242. To stop video time at 53 minute 05 seconds in VLC Media Player. 

 
Stop video here and ask if they can tell what is ‘Color replacer’ option? 

Just listen to the answers and play the video again for the correct answer. 

 

243. To stop video time at 54 minute 11 seconds in VLC Media Player. 

Stop video here and ask students to click on the ‘Tools menu’ and then click on 

‘Color replacer’ as shown in the video and then play the video again. 

 

244. To stop video time at 55 minute 56 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now just check whether they have replaced the picture’s color or not and play 

the video again. 

 

245. To stop video time at 56 minute 43 seconds in VLC Media Player. 

Stop video here and ask students to click on the ‘Tools menu’ and then click on 

‘Media player’ as shown in the video and then play the video again. 

 

246. To stop video time at 57 minute 18 seconds in VLC Media Player. 

Stop video here and ask students to insert any video as shown in the video and 

then play the video again. 
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247. To stop video time at 59 minute 08 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now just check whether they have inserted any video or not and play the video 

again. 

248. To stop video time at 59 minute 14 seconds in VLC Media Player. 

 
Stop video here and ask if they know why we use ‘Minimize presentation’ 

option? 

Just listen to the answers and play the video again for the correct answer. 

 

249. To stop video time at 1 Hour 00 minute 00 seconds in VLC Media 

Player. 

Stop video here and ask students to click on the ‘Tools menu’ and then click on 

‘Minimize presentation’ as shown in the video and then play the video again. 

 

250. To stop video time at 1 Hour 00 minute 49 seconds in VLC Media 

Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

251. To stop video time at 1 Hour 01 minute 51 seconds in VLC Media 

Player. 

Stop video here and ask students to do as shown in the video. 

Now just check whether they have used ‘Minimize presentation’ or not and play 

the video again. 

 

252. To stop video time at 1 Hour 00 minute 23 seconds in VLC Media 

Player. 
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Stop video here and ask students to close their file and shut down the computer. 
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Complete teacher’s manual for Open office Impress 2 Class 8 

Summaries 

 

 Why we use ‘Expand and summary slide’ ? 

 Why we use ‘animated image’ option ? 

 Why we use ‘Movie and sound’ ? 

 What is ‘object’ and ‘chart’ option ? 

 Why we use ‘position and size’ ? 

 Why we use ‘line’ option ? 

 What is area option ? 

 How to crop a picture ? 

 How to use style and formatting? 

 How to correct spelling? 

 How to change language ? 

 

Now let’s start the video. 

 

253. To stop video time at 34 seconds in VLC Media Player. 

 
Stop video here and ask if they remember what they learnt in previous class? 

Just listen to the answers and play the video again for the correct answer. 

 

254. To stop video time at 36 seconds in VLC Media Player. 
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Stop video here and ask if they know what is ‘animated image’? 

Just listen to the answers and play the video again for the correct answer. 

 

255. To stop video time at 1 minute 16 seconds in VLC Media Player. 

 
Stop video here and ask which option is used to ‘play MP3 or video’ file in 

impress slide? 

Just listen to the answers and play the video again for the correct answer. 

256. To stop video time at 1 minute 41 seconds in VLC Media Player. 

 
Stop video here and ask if we can cut picture using ‘crop picture’ option or not? 

Just listen to the answers and play the video again for the correct answer. 

257. To stop video time at 2 minute 07 seconds in VLC Media Player. 
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Stop video here and ask what is shortcut command for ‘spelling’?  

Just listen to the answers and play the video again for the correct answer. 

 

258. To stop video time at 2 minute 26 seconds in VLC Media Player. 

 
Stop video here and ask where are ‘text, area, line and styles and formatting’ 

options ?  

Just listen to the answers and play the video again for the correct answer. 

 

259. To stop video time at 2 minute 36 seconds in VLC Media Player. 

 
Stop video here and ask if they can tell what is ‘’color replacer’?  

Just listen to the answers and play the video again for the correct answer. 

260. To stop video time at 2 minute 51 seconds in VLC Media Player. 
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Stop video here and ask if they know why we use ‘minimize presentation’?  

Just listen to the answers and play the video again for the correct answer. 

261. To stop video time at 3 minute 28 seconds in VLC Media Player. 

 
Stop video here and ask students to first select title slide and then play the 

video. 

262. To stop video time at 3 minute 35 seconds in VLC Media Player. 

 
Stop video here and ask students to type the given line and then play the video  

again. 

263. To stop video time at 4 minute 20 seconds in VLC Media Player. 

Stop video here and ask students to copy paste the line as shown in the video 

and then play the video again. 

264. To stop video time at 4 minute 42 seconds in VLC Media Player. 
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Stop video here and ask students to bring up the new slide and then ask to use 

movie and sound. 

265. To stop video time at 5 minute 27 seconds in VLC Media Player. 

Stop video here and ask students insert a new slide as shown in the video and 

then play the video again. 

 

266. To stop video time at 6 minute 51 seconds in VLC Media Player. 

Stop video here and ask students to insert the video and then play the video 

again. 

 

267. To stop video time at 7 minute 40 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now just check whether they have inserted the video or not and then play the 

video again. 

  

268. To stop video time at 7 minute 51 seconds in VLC Media Player. 

 
Stop video here and ask students to insert the new slide and ask to make it as a 

summary slide and then play the video again. 

 

269. To stop video time at 7 minute 57 seconds in VLC Media Player. 
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Stop video here and ask students to make the ‘Expand slide’ as shown in the 

video and then play again. 

 

270. To stop video time at 10 minute 18 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now just check whether they have used ‘Summary slide’ or not and then play 

the video again. 

 

271. To stop video time at 10 minute 27 seconds in VLC Media Player. 

Stop video here and ask students to insert a new slide and then play the video 

again. 

 

272. To stop video time at 10 minute 37 seconds in VLC Media Player. 

 
Stop video here and ask if they know how to use animated image? 

Just listen to the answers and play the video again for the correct answer. 

 

273. To stop video time at 11 minute 33 seconds in VLC Media Player. 

Stop video here and ask students to click on the ‘Insert’ menu and then click 

‘Animated image’ as shown in the video and then play the video again. 

 

274. To stop video time at 12 minute 04 seconds in VLC Media Player. 

Stop video here and ask students to insert the picture and then click on the 

‘apply object’ option as shown in the video and then play the video again. 

 

275. To stop video time at 12 minute 39 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and the play the 

video again. 
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276. To stop video time at 14 minute 03 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and the play the 

video again. 

 

277. To stop video time at 15 minute 04 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now just check just whether they have made animated image or not and then 

play the video again. 

 

278. To stop video time at 15 minute 18 seconds in VLC Media Player. 

 
Stop video here and ask if they know how to use ‘Size and Position’? 

Just listen to the answers and play the video again for the correct answer. 

 

279. To stop video time at 15 minute 46 seconds in VLC Media Player. 

Stop video here and ask students to insert a new slide as shown in the video and 

then play the video again. 

 

280. To stop video time at 16 minute 10 seconds in VLC Media Player. 

Stop video here and ask students to draw an object as shown in the video and 

then play the video again. 

 

281. To stop video time at 16 minute 23 seconds in VLC Media Player. 

Stop video here and ask students to click on the ‘Format menu’ and then click 

on the ‘Size and Position’ and then play the video again. 

 

282. To stop video time at 17 minute 36 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now just check whether they have used ‘Size and Position’ option or not and 

then play the video again. 
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283. To stop video time at 17 minute 53 seconds in VLC Media Player. 

 
Stop video here and ask students to draw a picture using line ‘Tool line’ and 

also change the formatted line and then play the video again. 

 

284. To stop video time at 18 minute 32 seconds in VLC Media Player. 

Stop video here and ask students to draw as shown in the video and then play 

the video again. 

 

285. To stop video time at 18 minute 44 seconds in VLC Media Player. 

Stop video here and ask students to click on the ‘Format menu’ and then click 

on ‘Line’ option as shown in the video and then play the video again. 

286. To stop video time at 19 minute 44 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

287. To stop video time at 20 minute 28 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now just check whether they have formatted the line or not and then play the 

video again. 

288. To stop video time at 20 minute 38 seconds in VLC Media Player. 

 
Stop video here and ask if they know how to use ‘Area’ option? 
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Just listen to the answers and play the video again for the correct answer. 

 

289. To stop video time at 21 minute 36 seconds in VLC Media Player. 

Stop video here and ask students to insert a new slide and then draw an object 

and then play the video again.  

 

290. To stop video time at 21 minute 52 seconds in VLC Media Player. 

Stop video here and ask students to click on the ‘Format menu’ and then click 

on the ‘Area’ option as shown in the video and then play the video again. 

 

291. To stop video time at 23 minute 34 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

292. To stop video time at 24 minute 17 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now just check whether they have used ‘Area’ option or not and then play the 

video again. 

 

293. To stop video time at 24 minute 37 seconds in VLC Media Player. 

 
Stop video here and ask students to type the given spelling as shown in the 

video and also tell how to check the spelling then play the video again. 

 

294. To stop video time at 26 minute 09 seconds in VLC Media Player. 

Stop video here and ask students to type the given words as shown in the video 

and then play the video again. 

 

 

295. To stop video time at 27 minute 26 seconds in VLC Media Player. 
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Stop video here and ask students to correct the wrong spelling as shown in the 

video. 

Now just check whether they have corrected the spelling or not and then play 

the video again. 

 

296. To stop video time at 27 minute 26 seconds in VLC Media Player. 

 
Stop video here and ask students to insert any picture and then use the color 

replacer option to replace the color of the picture and then play the video again. 

297. To stop video time at 28 minute 33 seconds in VLC Media Player. 

Stop video here and ask students to insert a new slide and then insert a picture 

as shown in the video and then play the video again. 

298. To stop video time at 30 minute 40 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

299. To stop video time at 31 minute 14 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now just check whether they have replaced the color or not and then play the 

video again. 

300. To stop video time at 31 minute 25 seconds in VLC Media Player. 

 
Stop video here and ask students to insert any file/object on the sheet and then 

play the video again. 
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301. To stop video time at 32 minute 04 seconds in VLC Media Player. 

Stop video here and ask students to click on the video and then click on the 

‘Object’ option as shown in the video and then play the video again. 

 

302. To stop video time at 34 minute 25 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now just check whether they have inserted the file or not and then play the 

video again. 

 

303. To stop video time at 34 minute 35 seconds in VLC Media Player. 

 
Stop video here and ask if they know what happens with ‘Minimize 

presentation’ and why we use it? 

Just listen to the answers and play the video again for the correct answer. 

 

304. To stop video time at 35 minute 11 seconds in VLC Media Player. 

Stop video here and ask students to click on the ‘Tools menu’ and then click on 

the ‘Minimize presentation’ and then play the video again. 

 

305. To stop video time at 35 minute 40 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

306. To stop video time at 37 minute 43 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now just check whether they have done the use of ‘Minimize presentation’ or 

not and then play the video again. 

 

307. To stop video time at 38 minute 00 seconds in VLC Media Player. 
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Stop video here and ask students to close their file and shut down the computer. 
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Complete teacher’s manual for Open office Impress 2 Class 9 

Summaries 

 

 Why we use ‘Extension manager’ 

 Why we use ‘Auto correct’ option? 

 Why we use ‘Customize’ option’? 

 How to select any ‘Menu’? 

 How to design the slide? 

 Why we use ‘Option’?  

 Why we use ‘Interaction’? 

 How to apply effects on slide? 

 Why we use Custom animation? 

 Why we use slide transition? 

 Why we use ‘Custom slide show’? 

 

Now let’s start the video. 

308. To stop video time at 25 seconds in VLC Media Player. 

 
Stop video here and ask if they know what they learnt in the previous class? 

Just listen to the answers and play the video again for the correct answer. 

309. To stop video time at 30 seconds in VLC Media Player. 

 
Stop video here and ask, if they know what can we change using ‘Area option’? 
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Just listen to the answers and play the video again for the correct answer. 

 

310. To stop video time at 49 seconds in VLC Media Player. 

 
Stop video here and ask what can we change using ‘Line option’? 

Just listen to the answers and play the video again for the correct answer. 

 

311. To stop video time at 1 minute 10 seconds in VLC Media Player. 

 
Stop video here and ask, in which Menu ‘Animated image’ can be found and 

why we use it? 

Just listen to the answers and play the video again for the correct answer. 

312. To stop video time at 1 minute 43 seconds in VLC Media Player. 

 
Stop video here and ask if they can tell why use ‘Text’ option? 
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Just listen to the answers and play the video again for the correct answer. 

 

313. To stop video time at 2 minute 06 seconds in VLC Media Player. 

 
Stop video here and ask if they know why we use ‘Crop picture’ option? 

Just listen to the answers and play the video again for the correct answer. 

 

314. To stop video time at 2 minute 28 seconds in VLC Media Player. 

 
Stop video here and ask students to open ‘Impress file’ and then play the video 

again. 

 

315. To stop video time at 3 minute 10 seconds in VLC Media Player. 

 
Stop video here and check whether they have opened ‘Impress file’? 
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Now just check and then play the video again. 

 

316. To stop video time at 2 minute 41 seconds in VLC Media Player. 

 
Stop video here and ask students to insert four slides and type the given line on 

the 1
st
 slide and then play the video again. 

 

317. To stop video time at 3 minute 43 seconds in VLC Media Player. 

 
Stop video here and ask students to draw any shape on the second slide and also 

ask to type a line about those Shapes and then play the video again. 

 

318. To stop video time at 5 minute 08 seconds in VLC Media Player. 

Stop video here and ask students to insert a picture as shown in the video and 

then play video again. 

 

319. To stop video time at 6 minute 40 seconds in VLC Media Player. 

Stop video here and ask students to change the design of the slide as shown in 

the video and then play the video again. 

 

 

320. To stop video time at 7 minute 27 seconds in VLC Media Player. 
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Stop video here and ask students to change the design again as shown in the 

video and then play the video again. 

 

321. To stop video time at 7 minute 45 seconds in VLC Media Player. 

 
Stop video here and tell students if they know what work can do with help of 

the ‘Extension manager’ and how to use it? 

Just listen to the answers and play the video again for the correct answer. 

 

322. To stop video time at 9 minute 35 seconds in VLC Media Player. 

Stop video here and ask students to click on the ‘Tools menu’ and then click on 

‘Extension manager’ as shown in the video and then play the video again. 

 

323. To stop video time at 10 minute 57 seconds in VLC Media Player. 

Stop video here and ask students to download any extension as shown in the 

video and then play the video again. 

Note: - internet connection is required to download any contents. 

 

324. To stop video time at 13 minute 28 seconds in VLC Media Player. 

Stop video here and ask students to add the ‘Extension’ as shown in the video 

and then play the video again. 
 

325. To stop video time at 11 minute 52 seconds in VLC Media Player. 

Stop video here and ask students to open the Extension which they had 

downloaded as shown in the video and then play the video again. 

 

 

 

326. To stop video time at 14 minute 11 seconds in VLC Media Player. 
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Stop video here and ask students to open impress file and then play the video 

again. 

 

327. To stop video time at 15 minute 26 seconds in VLC Media Player. 

Stop video here and ask students to insert new object as shown in the video and 

then play the video again. 

 

328. To stop video time at 13 minute 26 seconds in VLC Media Player. 

Stop video here and ask students to check the extension which they had 

installed and play the video again. 

 

329. To stop video time at 15 minute 42 seconds in VLC Media Player. 

Stop video here and ask students to check the extension which they had 

installed and play the video again. 

Now just check and then play the video again. 

 

330. To stop video time at 14 minute 50 seconds in VLC Media Player. 

 
Stop video here and ask if they can tell why we use ‘Auto correct’? 

Just listen to the answers and play the video again for the correct answer. 

 

331. To stop video time at 16 minute 44 seconds in VLC Media Player. 

Stop video here and ask students to click on the ‘Tools menu’ and then click on 

‘Auto correct’ as shown in the video and then play the video again. 

 

332. To stop video time at 17 minute 12 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

333. To stop video time at 20 minute 02 seconds in VLC Media Player. 
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Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

334. To stop video time at 20 minute 42 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now just check whether they have used the ‘Auto correct option or not and then 

play the video again. 

  

335. To stop video time at 20 minute 50 seconds in VLC Media Player. 

 
Stop video here and ask them, if they know why we use ‘Customize’ option? 

Just listen to the answers and play the video again for the correct answer. 

 

336. To stop video time at 21 minute 42 seconds in VLC Media Player. 

Stop video here and ask students to remove ‘Hyperlink’ and ‘Object’ option 

from ‘Edit menu’ as shown in the video and then play the video again. 

 

337. To stop video time at 21 minute 56 seconds in VLC Media Player. 

Stop video here and ask students to click on the ‘Tools menu’ and then click on 

the ‘customize’ and then play the video again. 

 

338. To stop video time at 22 minute 46 seconds in VLC Media Player. 

Stop video here and ask students to remove the ‘Object’ and ‘Hyperlink’ option 

as shown in the video and then play. 

 

339. To stop video time at 24 minute 27 seconds in VLC Media Player. 

Stop video here and ask students to create the menu as shown in the video and 

then play the video again. 

 

340. To stop video time at 24 minute 52 seconds in VLC Media Player. 
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Stop video here and ask students to create a ‘Menu’ as shown in the video and 

then play the video again. 

 

341. To stop video time at 24 minute 52 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

342. To stop video time at 26 minute 54 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now just check whether they have created the menu or not and then play the 

video again. 

 

343. To stop video time at 27 minute 00 seconds in VLC Media Player. 

 
Stop video here and ask if they know why ‘Option’ option is used? 

Just listen to the answers and play the video again for the correct answer. 

 

344. To stop video time at 27 minute 43 seconds in VLC Media Player. 

Stop video here and ask students to click on the ‘Tools menu’ and then click on 

‘Option’ as shown in the video and then play the video again. 

 

345. To stop video time at 29 minute 25 seconds in VLC Media Player. 

Stop video here and ask students to change the view of impress file as shown in 

the video and then play the video again. 

 

346. To stop video time at 31 minute 38 seconds in VLC Media Player. 

Stop video here and ask students to do the normal view as shown in the video 

and then play the video again. 

 

347. To stop video time at 30 minute 50 seconds in VLC Media Player. 
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Stop video here and ask students to create own color name as shown in the 

video and then play the video again. 

 

348. To stop video time at 33 minute 20 seconds in VLC Media Player. 

Stop video here and ask students to create own color name as shown in the 

video and then play the video again. 

 

349. To stop video time at 34 minute 22 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

350. To stop video time at 37 minute 34 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

351. To stop video time at 39 minute 24 seconds in VLC Media Player. 

Stop video here and ask students to edit the ‘Grid’ option as shown in the video 

and then play the video again. 

 

352. To stop video time at 39 minute 47 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

353. To stop video time at 41 minute 39 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now just check whether they have used the ‘Option’ option and then play the 

video again. 

354. To stop video time at 41 minute 43 seconds in VLC Media Player. 

 
Stop video here and ask if they know why we use ‘Interaction’ option? 
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Just listen to the answers and play the video again for the correct answer. 

 

355. To stop video time at 42 minute 36 seconds in VLC Media Player. 

Stop video here and ask students to type any word on the title box as shown in 

the video and then play the video again. 

 

356. To stop video time at 42 minute 43 seconds in VLC Media Player. 

Stop video here and ask students to click on the ‘Tools menu’ and then click on 

‘Interaction’ as shown in the video and then play the video again. 

 

357. To stop video time at 43 minute 08 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

358. To stop video time at 45 minute 18 seconds in VLC Media Player. 

Stop video here and ask students to attach any document in title slide as shown 

in the video. 

Now just check and then play the video again. 

 

359. To stop video time at 45 minute 22 seconds in VLC Media Player. 

 
Stop video here and ask if they know why we use ‘Slide transition’ option? 

Just listen to the answers and play the video again for the correct answer. 

 

360. To stop video time at 46 minute 13 seconds in VLC Media Player. 

Stop video here and ask students to click on the ‘Tools menu’ and then click on 

‘Slide transition’ as shown in the video and then play the video again. 

 

 

361. To stop video time at 47 minute 50 seconds in VLC Media Player. 
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Stop video here and ask students to apply the effects on slides as shown in the 

video and then play the video again. 

 

362. To stop video time at 48 minute 10 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now just check whether they have applied ‘Slide transition’ or not and play the 

video again. 

 

363. To stop video time at 48 minute 12 seconds in VLC Media Player. 

 
Stop video here and ask if they know why we use ‘Custom animation’ option? 

Just listen to the answers and play the video again for the correct answer. 

 

364. To stop video time at 49 minute 25 seconds in VLC Media Player. 

Stop video here and ask students to draw a smiley face as shown in the video 

and then play the video again. 

 

365. To stop video time at 49 minute 38 seconds in VLC Media Player. 

Stop video here and ask students to draw an object as shown in the video and 

then play the video again. 

 

366. To stop video time at 49 minute 55 seconds in VLC Media Player. 

Stop video here and ask students to draw an object as shown in the video and 

then play the video again. 

 

367. To stop video time at 48 minute 21 seconds in VLC Media Player. 

Stop video here and ask students to customize the slides as shown in the video 

and then play the video again. 

 

368. To stop video time at 51 minute 54 seconds in VLC Media Player. 
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Stop video here and ask students to show slide show as shown in the video and 

then play the video again. 

 

369. To stop video time at 52 minute 35 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now just check whether they have customized the slides or not and then play 

the video again. 

 

370. To stop video time at 51 minute 01 seconds in VLC Media Player. 

 
Stop video here and ask students to close their file and shut down the computer. 
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Complete teacher’s manual for Open office impress 2 Class 10 

 Summaries 

 

 How to record a data, picture and drawing in impress file? 

 Why we use extension manager ? 

 How to use auto correct option ? 

 What is rehearse timing ? 

 Why we use interaction ? 

 How to use slide transition ? 

 Why we use custom slide show ? 

 

 

Now let’s start the video. 

 

371. To stop video time at 22 seconds in VLC Media Player. 

 
Stop video here and ask if they can tell why we use spelling? 

Just listen to the answers and play the video again for the correct answer. 

 

372. To stop video time at 40 seconds in VLC Media Player. 

 
Stop video here and ask if they know why we ‘Custom Animation’ option? 

Just listen to the answers and play the video again for the correct answer. 
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373. To stop video time at 1 minute 13 seconds in VLC Media Player. 

 
Stop video here and ask if they know what happens with ‘Customize’? 

Just listen to the answers and play the video again for the correct answer. 

 

374. To stop video time at 1 minute 39 seconds in VLC Media Player. 

 
Stop video here and ask if they know why we use ‘Rehearse timing’? 

Just listen to the answers and play the video again for the correct answer. 

 

375. To stop video time at 1 minute 58 seconds in VLC Media Player. 

 
Stop video here and ask if they know why we use interaction? 

Just listen to the answers and play the video again for the correct answer. 
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376. To stop video time at 2 minute 18 seconds in VLC Media Player. 

 
Stop video here and ask if they know what is custom slide show? 

Just listen to the answers and play the video again for the correct answer. 

377. To stop video time at 2 minute 42 seconds in VLC Media Player. 

 
Stop video here and ask students to turn on their computer and open ‘Impress 

file’ and then play the video again. 

378. To stop video time at 2 minute 47 seconds in VLC Media Player. 

Stop video here and check whether they have opened the impress file or not and 

then play the video. 

379. To stop video time at 3 minute 11 seconds in VLC Media Player. 
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Stop video here and ask students to insert 5 new slides and type this paragraph 

about ‘Computer Shiksha’ and then play the video again. 

 

380. To stop video time at 3 minute 29 seconds in VLC Media Player. 

Stop video here and ask students to insert picture and do formatting on this 

picture, after that they should practice ‘Custom animation’ option and then play 

the video again. 

 

381. To stop video time at 4 minute 42 seconds in VLC Media Player. 

Stop video here and ask students to insert slides and draw shape using drawing 

toolbar as shown in the video and then play the video again. 

 

382. To stop video time at 5 minute 27 seconds in VLC Media Player. 

Stop video here and ask students to change the formatting of the image and give 

the title for this picture as shown in the video and then play the video again. 

 

383. To stop video time at 6 minute 12 seconds in VLC Media Player. 

Stop video here and ask students to draw a image and do the formatting of the 

image as shown in the video and then play the video again. 

 

384. To stop video time at 6 minute 46 seconds in VLC Media Player. 

Stop video here and ask students to insert a picture from file option shown in 

the video and then play the video again. 

 

385. To stop video time at 7 minute 42 seconds in VLC Media Player. 

Stop video here and ask students to draw an image and do the formatting of the 

image as shown in the video and then play the video again. 

 

386. To stop video time at 9 minute 17 seconds in VLC Media Player. 

Stop video here and ask students to change the ‘slide design’ as shown in the 

video and then play the video again. 

 

387. To stop video time at 11 minute 24 seconds in VLC Media Player. 

Stop video here and ask students to apply the animation as shown in the video 

again. 
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388. To stop video time at 12 minute 29 seconds in VLC Media Player. 

Stop video here and ask students to use ‘custom animation’ and then show the 

slide show as shown in the video. 

Now just check whether they have used ‘Custom animation’ or not and play the 

video again. 

389. To stop video time at 11 minute 59 seconds in VLC Media Player. 

 
Stop video here and ask students to open another file using ‘Interaction’ option 

and then play the video again. 

390. To stop video time at 13 minute 16 seconds in VLC Media Player. 

Stop video here and ask students to click on the ‘Slide show’ and then click on 

‘Interaction’ option as shown in the video and then play the video again. 

391. To stop video time at 14 minute 09 seconds in VLC Media Player. 

Stop video here and ask students to attach the file as shown in the video and 

then play the video again. 

392. To stop video time at 14 minute 54 seconds in VLC Media Player. 

Stop video here and ask students to use ‘Interaction’ option as shown in the 

video and then play the video again. 

Now just check whether they have used ‘Interaction’ option or not and play the 

video again. 

393. To stop video time at 15 minute 09 seconds in VLC Media Player. 
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Stop video here and ask students to use the ‘Custom animation’ and then play 

the video again. 

 

394. To stop video time at 15 minute 35 seconds in VLC Media Player. 

Stop video here and ask students to select the paragraph and then click on the 

‘Slide show’ menu and then click on the ‘Custom animation’ option as shown in 

the video and then play the video again. 

 

395. To stop video time at 17 minute 09 seconds in VLC Media Player. 

Stop video here and ask students to apply the custom animation as shown in the 

video and then play the video again. 

 

396. To stop video time at 18 minute 52 seconds in VLC Media Player. 

Stop video here and ask students to do the practice of ‘Custom animation’ on 

every slide as shown in the video. 

Now just check whether they have practiced ‘custom animation’ option or not 

and play the video again for correct answer. 

 

397. To stop video time at 18 minute 58 seconds in VLC Media Player. 

 
Stop video here and ask students to do practice of ‘Rehearse timing’ and then 

play the video again. 

 

398. To stop video time at 21 minute 42 seconds in VLC Media Player. 

Stop video here and ask students to give the time for automatic slide show with 

time of every slide one by one using ‘rehearse timing’ as shown in the video 

and then play the video again. 
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399. To stop video time at 23 minute 21 seconds in VLC Media Player. 

Stop video here and ask students to apply ‘Rehearse timing’ as shown in the 

video. 

Now just check whether they have used ‘Rehearse timing’ option or not and 

play the video again. 

 

400. To stop video time at 23 minute 36 seconds in VLC Media Player. 

 
Stop video here and ask students to do practice of ‘Style and formatting option’ 

as shown in the video and then play the video again. 

 

401. To stop video time at 24 minute 15 seconds in VLC Media Player. 

Stop video here and ask students to click on the ‘Format menu’ and then click 

on the ‘Style and Formatting’ and then play the video again. 

 

402. To stop video time at 25 minute 13 seconds in VLC Media Player. 

Stop video here and ask students to change the background color as shown in 

the video. 

Now just check whether they have practiced ‘Styles and formatting’ option or 

not and play the video again for correct answer. 

403. To stop video time at 25 minute 18 seconds in VLC Media Player. 
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Stop video here and ask students to do the practice of ‘Slide Transition’ on 

every slide as shown in the video. 

404. To stop video time at 27 minute 56 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now just check whether they have practiced ‘Slide Transition’ option or not and 

play the video again for correct answer. 

405. To stop video time at 28 minute 14 seconds in VLC Media Player. 

 
Stop video here and ask students to give the effects using ‘slide transition’ and 

show slide show as shown in the video and then play the video again. 

406. To stop video time at 30 minute 20 seconds in VLC Media Player. 

Stop video here and ask students to apply the animation on the text and 

animation as shown in the video and then play the video again. 

407. To stop video time at 36 minute 30 seconds in VLC Media Player. 

Stop video here and ask students to apply the timing on each text and object as 

shown in the video and then play the video again. 

408. To stop video time at 38 minute 12 seconds in VLC Media Player. 

Stop video here and ask students to play the slide show as shown in the video. 

Now just check whether they have used ‘slide transition’ option or not and play 

the video again. 

 

 

 

 

 

 

 

 

 

 



111 
 

409. To stop video time at 38 minute 20 seconds in VLC Media Player. 

 
Stop video here and ask students to close their file and shut down the computer. 
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Complete teacher’s manual for Open office Impress 2 Class 11 

Summaries 

 

 Why we use ‘Interaction’ 

 Why we use ‘Custom animation’ option? 

 Why we use ‘Color replacer’ option’? 

 How to do any ‘Formatting on drawing? 

 How to insert a new slide? 

 How to use slides into ‘Summary slide’?  

 Why we use ‘Expand slide’? 

 What happens by ‘Properties’ option? 

 What happens by ‘Hyperlink’ option? 

 Why we use ‘Slide transition’? 

 

Now let’s start the video. 

 

410. To stop video time at 48 seconds in VLC Media Player. 

 
Stop video here and ask if they can tell why we use ‘Interaction’ option’? 

Just listen to the answers and play the video again for the correct answer. 

411. To stop video time at 1 minute 07 seconds in VLC Media Player. 

 
Stop video here and ask if they know why we use ‘Slide transition’ option? 
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Just listen to the answers and play the video again for the correct answer. 

 

412. To stop video time at 1 minute 33 seconds in VLC Media Player. 

 
Stop video here and ask if they can tell why we use ‘Minimize presentation’ 

option? 

Just listen to the answers and play the video again for the correct answer. 

 

413. To stop video time at 1 minute 51 seconds in VLC Media Player. 

 
Stop video here and ask if they can tell why we use ‘Slide design’ option? 

Just listen to the answers and play the video again for the correct answer. 

414. To stop video time at 2 minute 06 seconds in VLC Media Player. 
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Stop video here and ask students to open ‘Impress file’ and then play the video 

again. 

 

415. To stop video time at 2 minute 53 seconds in VLC Media Player. 

 
Stop video here and ask students to insert four slides and also to change design 

of each slide and then play the video again. 

 

416. To stop video time at 2 minute 23 seconds in VLC Media Player. 

 
Stop video here and ask students to type about ‘Computer Shiksha’ or ‘their 

own School’ and also to do formatting on the paragraph as explained in the 

video and then play the video again. 

 

417. To stop video time at 3 minute 15 seconds in VLC Media Player. 

Stop video here and ask students to change the formatting of  any line as told in 

the video and then play the video again. 

 

418. To stop video time at 4 minute 23 seconds in VLC Media Player. 

Stop video here and ask students to change the design of the slide as shown in 

the video and then play the video again. 

 

419. To stop video time at 6 minute 16 seconds in VLC Media Player. 

Stop video here and ask students to change the design of all slides as shown in 

the video and then play the video again. 
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420. To stop video time at 8 minute 04 seconds in VLC Media Player. 

Stop video here and ask students to do the formatting on the line as shown in the 

video.  

Now just check whether they have done all these formatting or not and play the 

video again. 

 

421. To stop video time at 8 minute 16 seconds in VLC Media Player. 

 
Stop video here and check whether they have completed the task or not and then 

play the video again. 

 

422. To stop video time at 8 minute 33 seconds in VLC Media Player. 

 
Stop video here and ask students to apply animation on the objects and text and 

then play the video again. 

 

423. To stop video time at 11 minute 29 seconds in VLC Media Player. 

Stop video here and ask students to draw some object and pictures on different 

slides as shown in the video and then play the video again.. 

 

 

 

424. To stop video time at 11 minute 51 seconds in VLC Media Player. 
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Stop video here and ask students to apply the custom animation as shown in the 

video and then play the video again. 

 

425. To stop video time at 13 minute 15 seconds in VLC Media Player. 

Stop video here and ask students to apply the animation as shown in the video. 

Now just check whether they have applied ‘Custom animation’ or not and then 

play the video again. 

 

426. To stop video time at 13 minute 38 seconds in VLC Media Player. 

 
Stop video here and ask students to insert any picture and change the 

background using the ‘Color replacer and then play the video again. 

 

427. To stop video time at 14 minute 50 seconds in VLC Media Player. 

Stop video here and ask students to draw objects and also do the formatting as 

shown in the video and then play the video again. 

 

428. To stop video time at 16 minute 05 seconds in VLC Media Player. 

Stop video here and ask students to click on the ‘Tools menu’ and then click on 

‘Color replacer’ as shown in the video and then play the video again. 

 

429. To stop video time at 17 minute 07 seconds in VLC Media Player. 

Stop video here and ask students to replace the background color of the picture 

as shown in the video. 

Now just check whether they have replaced the background color or not and 

then play the video again. 

 

 

 

430. To stop video time at 17minute 16 seconds in VLC Media Player. 
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Stop video here and ask students to do practice of ‘Slide transition’ and then 

play the video again. 

 

431. To stop video time at 17 minute 43 seconds in VLC Media Player. 

Stop video here and ask students to click on the ‘Slide shown and then click on 

the ‘Slide transition’ and then play the video again. 

 

432. To stop video time at 19 minute 47 seconds in VLC Media Player. 

Stop video here and ask students to apply effects and sound effects as shown in 

the video and then play the video again. 

 

433. To stop video time at 20 minute 30 seconds in VLC Media Player. 

Stop video here and ask students to do slide show as shown in the video. 

Now just check whether they have applied the ‘Slide transition or not and then 

play the video again. 

 

434. To stop video time at 20 minute 38 seconds in VLC Media Player. 

 
Stop video here and ask students if they know what happens with ‘Summary 

slide’? 

Just listen to the answers and play the video again for the correct answer. 
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435. To stop video time at 22 minute 02 seconds in VLC Media Player. 

Stop video here and ask students to type some title as shown in the video and 

then play the video again. 

 

436. To stop video time at 22 minute 41 seconds in VLC Media Player. 

Stop video here and ask students to create the Summary slide as shown in the 

video. 

Now just check whether they have created the summary slide or not and then 

play the video again. 

 

437. To stop video time at 22 minute 56 seconds in VLC Media Player. 

 
Stop video here and ask students to convert ‘Summary slide into ‘Title slide’ 

and then play the video again. 

 

438. To stop video time at 23 minute 56 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now just check and then play the video again. 

439. To stop video time at 24 minute 15 seconds in VLC Media Player. 

 
Stop video here and ask students to insert one more slide and in this slide ask 

them to attach any file on it as shown in video and then play the video again. 
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440. To stop video time at 24 minute 45 seconds in VLC Media Player. 

Stop video here and ask students to click on the ‘Hyperlink’ option as shown in 

the video and then play the video again. 

 

441. To stop video time at 26 minute 14 seconds in VLC Media Player. 

Stop video here and ask students to insert hyperlink as shown in the video and 

then play the video again. 

 

442. To stop video time at 26 minute 54 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now just check whether they have inserted the ‘Hyperlink’ or not and then play 

the video again. 

 

443. To stop video time at 27 minute 05 seconds in VLC Media Player. 

 
Stop video here and ask students to convert their file into ‘MS Power point’ and 

then play the video again. 

 

444. To stop video time at 27 minute 47 seconds in VLC Media Player. 

Stop video here and ask students to click on the ‘File menu’ and then click on 

‘Wizard’ as shown in the video and then play the video again. 

 

445. To stop video time at 29 minute 22 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now just check whether they converted the document or not and then play the 

video again. 

 

446. To stop video time at 29 minute 32 seconds in VLC Media Player. 



120 
 

 
Stop video here and ask students to tell all information about the file as shown 

in the video and then play the video again. 

 

447. To stop video time at 30 minute 39 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now just check whether they have practiced the ‘Property’ option or not and 

then play the video again. 

 

448. To stop video time at 30 minute 48 seconds in VLC Media Player. 

 
Stop video here and ask students to close their file and shut down the computer. 

 

 


